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Document 
Revision History 

This user guide provides basic information about using the Microtronix 
Stratix III Broadcast IP development kit.  The following table shows the 
document revision history. 

Date Rev Description 

April 2009 1.0 Initial Release 

 

E-mail How to Contact 
Microtronix Sales Information: sales@microtronix.com 

Support Information: support@microtronix.com 

Website 

Software updates to the Stratix III Development Kit and supporting 
Microtronix IP Cores are listed on the download page of our website 
and made available via an email request form.  Some product 
upgrades are only available to customers who have purchased the 
Stratix III kit.   

The upload site is for sending files to Technical Support.  

General Website: http://www.microtronix.com 

Downloads Page: http://www.microtronix.com/downloads/ 

FTP Upload Site:  http://microtronix.leapfile.com 

Phone Numbers 

General: (001) 519-690-0091 

Fax: (001) 519-690-0092 

Typographic 
Conventions 

Path/Filename A path/filename 

[SOPC Builder]$ <cmd> A command that should be run from 
within the Cygwin Environment. 

Code Sample code. 

!  Indicates that there is no break between 
the current line and the next line. 
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The Microtronix Stratix Broadcast IP Development Kit  is targeted at 
the development of consumer video display, imaging and broadcast 
video systems. It demonstrates the capabilities of Altera's Stratix III for 
broadcast video enhancements applications. 

Introduction  

 

The Microtronix Stratix III Broadcast IP Development Kit  includes the 
following hardware components:  

Kit Contents 

!" Altera Stratix III Development Board 

o Stratix III FPGA (EP3SL150F1152C2) 

!" MicrotronixÕs HDMI (PN: 6256-20-00) Receiver / Transmitter 
Board  

o Mounting hardware 

!" National Semiconductor SDALTEVK HSMC SDI Adapter board 

o Mounting hardware 

!" USB Blaster  

!" DC Power Adapter  

!" Microtronix Stratix III Reference Design CD 
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A picture of the Stratix III development board with the HDMI Rx/Tx 
and Triple-rate SDI Interface card  is shown in Figure 1.  The 
Microtronix HDMI Receiver / Transmitter Board is shown in the next 
Figure 2 and the National SDALTEVK Triple-speed SDI Adapter bioard 
in Figure 3. 

Overview 

 

Figure 1: Stratix III Development Board with HDMI and SDI Daughter 
Card 

 

 

Figure 2: Microtronix HDMI Receiver / Transmitter Board 
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Figure 3: National SDALTEVK SDI Adapter board 
 

User LEDs Stratix III 
Development 
Board – 
Frequently used 
Pin-Outs 

There are eight general purpose LEDs driven by the Stratix III device. 
The LEDs illuminate when a logic 0 is driven, and do not illuminate 
when a logic 1 is driven.  The I/O standard for these pins should be set 
to 1.8V. 

Table 1: Stratix III – LED pin assignments 

LED Pin Number 

LED0 F21 

LED1 C23 

LED2 B23 

LED3 A23 

LED4 D19 

LED5 C19 

LED6 F19 

LED7 E19 
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User Push Buttons 

There are four general-purpose push buttons and one user reset button 
driving inputs on the Stratix III device.   The I/O standard for these pins 
should be set to 1.8V.  

 

Table 2: Stratix III – Switch /push button pin assignments 

Switch Pin Number 

S2 K17 

S3 A16 

S4 A17 

S5 B17 

S6 (Reset) AP5 

 

 

DDR2 SDRAM DIMM 

The Stratix III development board has 1Gbyte DDR2 SDRAM DIMM 
memory interface with 72-bit data width.  Typically the 64-bit wide data 
bus is used and the additional 8 bits serve as an error correction coding 
for each 8-byte data lane.   

For more information, refer to Table 2-45 (page 57) in the 
StratixIII_3sl150_dev_reference_manual.pdf  

 

DDR2 SDRAM Devices  
The board has two 8-bit DDR2 SDRAM devices.  Please refer to Table 
2-47 in the stratixIII_3sl150_dev_reference_manual.pdf for pin-out 
information. 

 

High Speed Mezzanine Connectors (HSMC) 

The Stratix III board has two High Speed Mezzanine Connectors 
(HSMC) called Port A and Port B. 

Please refer the Table 2-41 in the AlteraÕs Stratix III manual for specific 
pin-out of the HSMC connectors.  The table below shows the pin 
locations for the commonly used signals on the two ports.  In most of 
the MicrotronixÕs reference designs, the HDMI daughter card is 
connected to PORT B and the SDI interface card is connected to 
PORT A. 
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Table 3: PORT A and B pin assignments 
PORT A – (SDI Interface Card Connections) 

SDI Signal PIN 
Assignment 

SDI SIGNAL PIN 
Assignment 

freerun AD28 clkout_sma AE23 

pll_sda P8 b_clk_nolock F28 

rx1_sda AJ9 b_clk_noref F27 

sclock AA32 b_extclk A15 

tx1_sda AK9 b_freerun J22 

tx2_sda AL7 b_hsync_p T25 

extclk AG14 b_oddeven_p P21 

rx1_clk_p T2 b_pll_sda H26 

sdiclk0_p Y4 b_reset L24 

tx1_clk_p Y6 b_reset_n H24 

tx2_clk_p AD7 b_rx1_clk_p Y27 

rx1_d_p[0] AB2 b_rx1_d_p[0] U22 

rx1_d_p[1] AA1 b_rx1_d_p[1] W28 

rx1_d_p[2] AC4 b_rx1_d_p[2] V23 

rx1_d_p[3] AB4 b_rx1_d_p[3] AB27 

rx1_d_p[4] AA4 b_rx1_d_p[4] AC27 

tx1_d_p[0] AA7 b_rx1_sda H23 

tx1_d_p[1] Y8 b_sclock H25 

tx1_d_p[2] Y10 b_sdiclk0_p J27 

tx1_d_p[3] W12 b_sdiclk_en1 L23 

tx1_d_p[4] AA12 b_sdiclk_sel0 J25 

tx2_d_p[0] AE6 b_sdiclk_sel1 J26 

tx2_d_p[1] AD4 b_tof_p U27 

tx2_d_p[2] AC6 b_tx1_clk_p AA25 

tx2_d_p[3] AB6 b_tx1_d_p[0] AB25 

tx2_d_p[4] AB8 b_tx1_d_p[1] Y23 

clk_nolock AJ3 b_tx1_d_p[2] AE27 

clk_noref AJ4 b_tx1_d_p[3] W22 

hsync_p AE4 b_tx1_d_p[4] V21 

oddeven_p AF2 b_tx1_sda G24 

reset AG4 b_tx2_clk_p R25 

reset_n AL9 b_tx2_d_p[0] U25 
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sdiclk_en1 AC9 b_tx2_d_p[1] V27 

sdiclk_sel0 AC11 b_tx2_d_p[2] V25 

sdiclk_sel1 AB10 b_tx2_d_p[3] W25 

tof_p AC2 b_tx2_d_p[4] Y25 

vformat_p AE2 b_tx2_sda G25 

clkin_sma AH14 b_vformat_p R22 

 

PORT B – (HDMI Board Connections) 

HDMI Signal PIN 
Assignment 

HDMI Signal PIN 
Assignment 

hdmi_rx_r[0] N2 hdmi_tx_clk P6 

hdmi_rx_r[1] P1 hdmi_tx_de K5 

hdmi_rx_r[2] M1 hdmi_tx_hs J7 

hdmi_rx_r[3] N1 hdmi_tx_vs J6 

hdmi_rx_r[4] L2 hdmi_tx_r[0] H1 

hdmi_rx_r[5] L1 hdmi_tx_r[1] G2 

hdmi_rx_r[6] K4 hdmi_tx_r[2] J1 

hdmi_rx_r[7] K3 hdmi_tx_r[3] H2 

hdmi_rx_g[0] AB25 hdmi_tx_r[4] L6 

hdmi_rx_g[1] AF31 hdmi_tx_r[5] L7 

hdmi_rx_g[2] R4 hdmi_tx_r[6] M6 

hdmi_rx_g[3] R3 hdmi_tx_r[7] M7 

hdmi_rx_g[4] P4 hdmi_tx_g[0] D1 

hdmi_rx_g[5] P3 hdmi_tx_g[1] C1 

hdmi_rx_g[6] P2 hdmi_tx_g[2] E1 

hdmi_rx_g[7] R1 hdmi_tx_g[3] E2 

hdmi_rx_b[0] AF32 hdmi_tx_g[4] H3 

hdmi_rx_b[1] P11 hdmi_tx_g[5] H4 

hdmi_rx_b[2] P10 hdmi_tx_g[6] G1 

hdmi_rx_b[3] T9 hdmi_tx_g[7] F1 

hdmi_rx_b[4] T8 hdmi_tx_b[0] N10 

hdmi_rx_b[5] T7 hdmi_tx_b[1] N11 

hdmi_rx_b[6] U6 hdmi_tx_b[2] F3 

hdmi_rx_b[7] T5 hdmi_tx_b[3] F4 

hdmi_rx_clk N4 hdmi_tx_b[4] G4 
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hdmi_rx_de R7 hdmi_tx_b[5] G5 

hdmi_rx_f AB24 hdmi_tx_b[6] D2 

hdmi_rx_hs N9 hdmi_tx_b[7] D3 

hdmi_rx_vs R6   

 

 

 

Digital Video 
Receiver / 
Transmitter Board 

Included with the Stratix III Broadcast IP Kit is a Microtronix HDMI 
Receiver / Transmitter daughter board.  When acting as a video 
receiver, these boards may be installed on either HSMC header. The 
reference designs that incorporate video output require the use of this 
card and installed on Port B HSMC header.   

 

HDMI Receiver / 
Transmitter Board 

The Microtronix HDMI Receiver / Transmitter Daughtercard interface a 
HDMI receiver and transmitter to your Altera FPGA development kit 
using the HSMC expansion connector. The receiver also supports an 
analog component video (YCbCr) interface. 

The card uses the Analog Device AD9889 HDMI v1.1 transmitter to 
support HDTV formats up to 1080i at 60 Hz. Using an 80 MHz, high-
definition multimedia interface (HDMI 1.1) transmitter. With the 
inclusion of HDCP an encryption key, the AD9889 allows the secure 
transmission of protected content as specified by the HDCP 1.1 
protocol. 

The AD9880 HDMI Receiver offers designers the flexibility of an analog 
interface and digital high definition multimedia interface (HDMI) v1.1 
receiver integrated on a single chip. The receiver supports resolutions 
to 1080p at 60 Hz. 

The cards can support high band-width digital content protection 
(HDCP) when programmed with a HDCP encryption key. 

The Microtronix HDMI Receiver / Transmitter Daughter Card is supplied 
with HD a pass-through reference design for the Altera Stratix III 
Broadcast IP Kit and the Microtronix ViClaro III HD Display Panel - 
Video IP Dev Kit.   

 

SDI Interface Card Included with the Stratix III Broadcast IP Kit is the National 
SDALTEVK HSMC SDI Adapter interface card.  The card is used to 
send and received data in SDI format.  Please refer to the NationalÕs 
SDI Adapter user manual for specific details of the card.  The reference 
designs that incorporate SDI input/output or clock input from the SDI 
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card require the use of this card and needs to be installed on Port A 
HSMC header on Stratix III host board. 

The Microtronix Stratix III Reference Designs require an installed 
version of the Altera Quartus II version 8.1 FPGA design software 
supplied with the board.  A newer version of Quartus may be available 
from AlteraÕs website.   

Installation of 
Stratix III 
Reference 
Designs 

The Reference Designs are supplied by Microtronix on a CD or as a 
zipped file.  If you received the latter, unzip the file to a temporary file 
directory and run the setup.exe file.  The software should self-install 
from the CD or it can be manually installed by running the setup.exe 
file.  

WARNING:  Remove older installations of the Microtronix Reference 
Designs from the PC prior to installing the new version of software.   

 

 Stratix III Setup 
and Configuration Connecting the Cables and Daughter Cards 

Remove the Stratix III board from its protective ESD bag.  
NOTE: Use good ESD practices to avoid electrically damaging the 
boards.  

1. Mount the HDMI Rx/Tx Board on ÔPort BÕ using the supplied 
mounting hardware.  

2. Mount the SDI Interface Card on ÔPort AÕ using the supplied 
mounting hardware. 

3. Power the AC-DC 14V-20V adapter and connect to J21.   

4. Connect the Altera USB Blaster JTAG cable to J5 on the Stratix III 
host board and a USB port on the PC/laptop.  

5. Connect the SDI or HDMI output from the TX port on the respective 
daughter board to the auxiliary display monitor or system. 

 

6. Connect the SDI or HDMI input to the RX port on the respective 
daughter board from the source device.   

  
 

Running Video 
Reference Designs 

The Stratix III Broadcast Kit includes a number of pre-compiled 
Quartus reference designs to demonstrate the functionality of the 
board.   

The designs are supplied as pre-compiled SOF files and also as 
Quartus design files with the full source.  The SOF files can be run by 
downloading them through the JTAG port into the Stratix III FPGA on 
the board.  
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NOTE: An Altera USB-Blaster cable is required to load SOF program 
files onto the Stratix III host board. 

Configure USB-Blaster 

This step is required if the USB-Blaster has not yet been configured to 
work with the Quartus software.  

1. Connect the USB-Blaster to the USB-JTAG port of the Stratix III 
board.  

2. Plug the other end of the cable into the PC/Laptop.  

3. Start Quartus.  

4. Connect to the JTAG programmer by selecting > Tools > 
Programmer > Hardware.  

a. Click on Hardware Setup box.  Confirm/select USB-Blaster. 

b. Click on Auto Detect box. This will find the programmable 
devices on the Stratix III board. 

 

The Stratix III Reference Designs are supplied as pre-compiled SOF 
files and as Quartus design files with the full source. The SDI and 
HDMI based designs require a variety of video sources and a monitor 
with an HDMI input supporting resolutions of 720p and 1080p 
50/59.94/60Hz.  

Overview of 
Reference 
Designs 

The designs are listed in the following table.  

  

Table 4: Quartus Reference Designs 

Description Directory & Filename 

1080i to 1080p deinterlacer @ 60 Hz 
HDMI reference design:  

Example/stratixIII/deinterlace_1080i/ 
deinterlace_s3_1080i.sof 

1080p Picture-in-Picture @ 60 Hz. 
HDMI reference design: 

   Example/stratixIII/PiP/pip.sof 

SDI Loop-through VIP 
SDI reference design: 

example/sdi_vip_loopthru/sdi_vip_loop.sof 

SDI-in HDMI-out  
SDI reference design: 

example/SDI_in_HDMI_out/sdi_in_hdmi_out.sof 

 

Microtronix IP Cores 

The Stratix III reference designs incorporate the Microtronix Avalon 
Multi-port DDR2 SDRAM Memory Controller and the Microtronix I2C 
Master / Slave / PIO Controller IP Cores.   
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The Stratix III Kit purchase includes the following IP Core licenses: 

!" A full 1-year license for the Avalon Multi-port DDR2 SDRAM 
Memory Controller 

!" A full 1-year license for the I2C Master / Slave /PIO Controller 

!" Extended OpenCore Plus licenses for the following Microtronix 
IP cores:  

o Avalon Multi-port SDRAM Memory Controller 

o I2C Master/Slave/PIO Controller 

To receive your IP core license contact sales sales@microtronix.com 
and provide them with the serial number of your board.  These licenses 
are required if you are to recompile or develop new Quartus projects 
incorporating Microtronix IP cores.  

 

 Block 
Diagrams 1080i to 1080p Deinterlacer 

The following diagram provides an overview of the IP blocks required 
for the deinterlacer design.  Pressing reset pushbutton resets the Nios 
II processor. 

MTX Avalon Multi-port
DDR2 SDRAM Ctrlr

256 MB DDR2 Memory

128-bit Avalon-MM

DVI
Txmtr

Motion
Adaptive

Deinterlacer

24-bit Avalon-ST

BUS LEGEND

1080i
Video In Clocked

Video
Out

DVI
Rcvr

Nios
I2C

Master
On-chip
Memory

I2C

1080p
Video
Out

24-bit RGB

Ctrl

5-Ports

Clocked
Video In

64-bit bus @ 167 MHz

 

Figure 4: Block diagram of HD Deinterlacer System 
 

PLL CLOCK DOMAINS 

The DDR2 memory uses one PLL running at 267MHz.  The HDMI 
transmitter uses one PLL running at 148.5MHz.  The SOPC Builder 
system operates from another PLL with two outputs.  The Nios II 
processor and peripherals run at 50MHz while the video IP runs at 
148.5MHz. 
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AVALON MULTI-PORT DDR2 SDRAM MEMORY CONTROLLER 

The Avalon Multi-port DDR2 SDRAM Memory controller interfaces to 
the DDR2 using a 64-bit data bus.  

ALTERA VIP SUITE 

This design uses the Clocked Video Input and Clocked Video Output to 
interface to the HDMI transmitter and receiver.  The Deinterlacer 
component is used in Motion Adaptive mode to convert the incoming 
1080i video to 1080p.  

HDMI RECEIVER/TRANSMITTER 

The data interfaces are 24-bits wide to the receiver and transmitter. 
These ICÕs are configured by an I2C master controller by software 
running on the Nios II processor.  

 

Picture in Picture  

The following diagram provides an overview of the IP blocks required 
for the Picture-in-Picture design.  Pressing reset pushbutton resets the 
Nios II processor. 

Microtronix Avalon Multi-port
DDR2 Memory Controller

64-bit
DDR2
Mem.

1080p
PiP

Video Out

Clocked
Video In

480p
Video In HDMI

Video
Txmtr

Frame
Buffer

HDMI
Video
Rcvr

267 MHz
S

S

M

M

Scaler
Clocked
Video In

1080p
Scaler

Clocked
Video Out

MUX

Stratix III EP3SL150

M

M

Frame
Buffer

S

M M

S

M

Frame
Buffer

M

Nios

On-chip
Memory

I2C Master

Avalon-MM

Avalon-ST

BUS LEGEND

RGB

I2CControl

Test
Pattern

Generator

S S

S S

Frame
Buffer

 

Figure 5: Block diagram of Picture in Picture System 

PLL CLOCK DOMAINS 

The DDR2 memory uses one PLL running at 267MHz.  The DDR2 
clock to the controller is set to 267, while the DDR2 write clock is also 
set to 267 but with a -90 degree phase shift. For some DIMM modules 
it may be necessary to enable shifted command clock, which has the 
same frequency as the DDR2 clock however it is phase shifted by 270 
degrees.  The HDMI transmitter, Nios II processor and Video IP use 
one PLL running at 148.5MHz.   
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AVALON MULTI-PORT DDR2 SDRAM MEMORY CONTROLLER 

The Avalon Multi-port DDR2 SDRAM Memory controller interfaces to 
the DDR2 using a 64-bit data bus.  

ALTERA VIP SUITE 

This design uses the Clocked Video Input and Clocked Video Output to 
interface to the HDMI transmitter and receiver.  The Scalar 
components use Bilinear scaling algorithm to upscale one input feed to 
1080p and the other to 360x240 resolutions. Frame buffers are used to 
buffer video data in a FIFO to sync the two input feeds.  Also, AlteraÕs 
Mixer component is used to display the two video feeds as one output. 

HDMI RECEIVER/TRANSMITTER 

The data interfaces are 24-bits wide to the receiver and transmitter. 
These ICÕs are configured by an I2C master controller by software 
running on the Nios II processor.  

 

 

SDI Loop through Avalon-ST framework 

The following diagram provides an overview of the IP blocks required 
for the SDI Loop through design.  Pressing reset pushbutton resets the 
Nios II processor. 

SDI IN
1080i SDI

Rcvr
LMH0341

Stratix III EP3SL150

Smart Serdes
Transmitter

Nios
On-chip
Memory

SDI
Txmtr

LMH0340
SDI MegaCore

Smart Serdes
Receiver

SDI MegaCore

Clocked
Video Out

Clocked
Video In

Avalon Video
Framework

SDI OUT
1080i

Avalon-ST

BUS LEGEND

RGB

SM Bus

YCbCr

 

Figure 6: Block diagram of SDI – VIP Looped Video System 
 

This design is a modified version of the AlteraÕs Smart SerDes 
Reference design.  It interfaces the Stratix III FPGA with the National 
Semiconductor SDI daughter card which is supplied with the Stratix III 
Broadcast Kit.  The Avalon Video framework path has been added in 
the SDI loop as shown in the above diagram.  This will allow the 
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engineers to process the SDI data using the Avalon ST components 
and output the processed data over the SDI link.  

PLL CLOCK DOMAINS 

There are two PLLs used in this design.  One outputs 50 MHz clock 
used to clock various components.  The second PLL outputs 175 MHz 
clock which is used to run the VIP components. 

ALTERA VIP SUITE 

This design uses the Clocked Video Input and Clocked Video Output to 
pass through the serial video data.   

SDI RECEIVER/TRANSMITTER 

These ICÕs are configured using SMBus by software running on the 
Nios II processor.  

 

 

SDI Input Ð HDMI Output Reference Design 

The following diagram provides an overview of the IP blocks required 
for the SDI Input to HDMI output design.  Pressing reset pushbutton 
resets the Nios II processor. 

SDI IN
720p SDI

Rcvr
LMH0341

Stratix III
EP3SL150

Nios
On-chip
Memory

HDMI
Txmtr

AD9889B

Smart Serdes
Receiver

SDI
MegaCore

HDMI OUT
720p 24

5 20

I2C Master

Avalon Video
Framework Chroma

Resampler

Color Space
Converter

Clocked
Video Out

Clocked
Video In

Microtronix
Avalon

Multi-port
DDR2

Memory
Controller

64-bit
DDR2 Mem.

Frame
Buffer

S

M

M

S

267 MHz
Avalon-ST

BUS LEGEND

RGB

SM Bus

YCbCr

SDI

I2C

 

Figure 7: Block Diagram of HD SDI-input and HDMI-output System 
 

This design demonstrates the data processing on SDI input using the 
AlteraÕs Avalon ST framework.  The 720p HD SDI input is converted to 
RGB color space using Chroma Re-Sampler 

PLL CLOCK DOMAINS 

The design uses two PLLs, one with a 50 MHz output clock which is 
used to drive various SerDes design components and the Nios II 
processor.  The second PLL is instantiated within the SOPC. It is used 
to drive VIP components and the MicrotronixÕs DDR2 memory 
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controller.  It has four output clocks, one with the frequency of 74.25 
MHz which is used to drive the VIP components and the HDMI 
transmitter block.  The other three outputs have the frequency of 267 
MHz but with 0, -90 and 270 degree phase shifts.  The -90 degree 
phase shifted clock is DDR2 write clock used by the MicrotronixÕs 
memory controller.  The 270 degree phase shifted clock is used drive 
the command clock port on the memory controller. 

AVALON MULTI-PORT DDR2 SDRAM MEMORY CONTROLLER 

The Avalon Multi-port DDR2 SDRAM Memory controller interfaces to 
the DDR2 using a 64-bit data bus.  

ALTERA VIP SUITE 

This design uses the Clocked Video Input and Clocked Video Output to 
interface to the SDI receiver and HDMI transmitter.  The Chroma 
Resampler and Color space converter components are used to convert 
from 4:2:2 YCbCr space to 4:4:4 RGB color space. A Frame buffer is 
used to store frames and synchronize the output video data.   

HDMI TRANSMITTER 

The data interfaces are 24-bits wide to the transmitter. The transmitter 
IC is configured by an I2C master controller by software running on the 
Nios II processor.  

SDI RECEIVER 

The receiver IC is configured using SMBus by software running on the 
Nios II processor.  

 

Running the 
Reference 
Designs 

WARNING: Make sure there is no HDMI cable from the laptop/PC to 
the Stratix III board until the Stratix III board is fully programmed and 
operational.   

From within Quartus, under the Tools menu, open Programmer.  
i.e.  > Tools > Programmer  

1. Click Auto Detect. 

2. Select the EP3SL150 from the three items listed.  Right click > 
Change File.   

3. Browse to the location of the deinterlacer_1080i.sof  programming 
file.  Select the appropriate file for the matching the refresh rate of 
your auxiliary monitor. It will be located in the directory where the 
files were extracted.   

4. Select/highlight the file > Open. The file will be listed under the file 
column of the EP3SL150 device.   
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5. Click the check box under the Program / Configure column.  

6. Click on the Start box to program the device.  

7. Connect the HDMI cable from the display monitor to the TX 
connector on the DVI or HDMI Board. The board will deinterlace 
1080i input video to 1080p.  

 

Importing 
Software 

All of the SOPC Builder based example designs include software to 
configure the hardware.  These software projects can be imported into 
the Nios II IDE to be recompiled or modified.  

1. From within Nios II IDE, under the File menu, select Import.   

2. Select Altera Nios II -> Existing Nios II IDE project into workspace, 
click Next. 

3. Browse to the software  directory of the example design of interest.  
There will be two subdirectories, the import process must be 
repeated for each (e.g. mixer_hdmi, mixer_hdmi_syslib). 

4. Select one of the subdirectories under software  and click OK.   

5. Click Finish to start the import.   

6. A dialog may appear asking to remove the Release and/or Debug 
directories, click Yes. 

7. Repeat for this process for the second subdirectory under 
software .   

 Page 18 of 19 



Stratix III SDI/ASI Broadcast Video IP Development Kit User Manual 

 Page 19 of 19 

 

Appendix A: 
Loading Designs 
into the FPGA 

The following procedure can be used to load a SOF file to the FPGA 
through JTAG.  These steps require the board to be powered and 
connected to the PC through a JTAG cable (USB-Blaster, etc). 

1. Start Quartus.  

2. From the Tools menu, select Programmer. 

3. Click Auto Detect. 

4. Select the line with the EP3SL150 device. 

5. Click Change File and browse to the SOF file (reference design) 
you wish to load. 

6. Check the Program/Configure box.  

7. Click Start to program the FPGA. 
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